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1.
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System

This guide provides assistance to users of the software package (RWQO Model vs. 2.0)
for the determination of Resource Water Quality Objectives (RWQOs) for surface water
resources. For detail on the methodology behind this system, the user is referred to the
"Guideline for determining Resource Water Quality Objectives (RWQOs) , Allocatable
Water Quality and the Stress of the Water Resource" (DWAF, 2006), accessible from
within the Model or on the enclosed CD. The software is freely available from the
Department of Water Affairs and Forestry.

Setup

B  Software Version

This Users Guide is applicable to version 2.0 of the RWQOs Model, developed by the
CSIR for the Department of Water Affairs and Forestry (DWAF).

B Setting Up

The RWQOs Model is a computer-based application which can be run either from the
setup CD or from a computer. To run the Model from the CD locate and open the file
run.bat. To run the Model from the computer, the user should copy the relevant folder and
associated files from the CD and paste them into a folder created for the application.

% I:\Water Programme - Pretoria\Shared Projects\Externa =|0| x|
File Edit View Favorites Tools Help | l';'
QBack v & ~ (¥ | P search |[L" Folders | [EI+
Address| c:\Rw0Qs Model\RWQO vs3 B
Folders X | Name = | Sizel Type | Date Modified
) = D) docs Folder 30/06/2006 11:29
= 2 DWAF ED_WQMP —I )jrel.5.0_06 Folder 30/06/2006 11:30
C 1stE |t.|_0r1 Management Ihstruments ) projects Folder 30/06/2006 11:33
= 22 2nd edition management instruments ) stage Folder 30/06/2006 11:33
[ Monitoring [Chthirdparty Folder 30/06/2006 11:33
= I3 RWOQs Model ﬁ'dwaf_icun.icu 4 KB Icon 14/03/2006 11:34
[ RWQO & run.bat 1 KB MS-DOS ... 05/04/2006 09:34
) RWQO vs2 =) ER rwyo.ico 4 KB Icon 28/06/2006 17:02
= 3 RWQO vs3
[ docs Copy and paste
- or drag folder to ——
D jre1.5.0_06 our (?om uter Note: replace with file
[T projects y puter.
P structure once
O stage transferred onto CD.
[ thirdparty -
[ | W4 | B

The Model is a standalone application and requires no additional software to run. Should
users wish to open any of the available documents within the Model [See Functions], they
will need Acrobat Reader. The setup file for Acrobat Reader is enclosed on the attached
CD or can be downloaded from www.adobe.com.

Page 1
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System Requirements

RDMWQ: Management Instruments:
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There are no specific system requirements to operate the RWQOs Model.

Quick Start

What you need to know and do to get started:

1. Copy the folder from the CD to your
2. Locate and Open the file run.bat

computer

3.  You are now ready to begin a new project, or an existing saved project.

# Resource Water Quality Objectives Beta j

File Tools Help

{Introduction [ Input_| BestAEMC | References | Monthly-Flow

| End-of-Pipe | Report |

=g

5

x|

Project Name | |
Study Unit Name | |

[»

User Existing? Future? Category
Recommended ecological category International obligations m| m|
| Strategic use i n
i1 Ecological Reserve [T+
Use to set the Ecological Reserve Category . . - U L
‘% Ecological Requirements i n B
S b | | | Basic Human Needs ] ]
Natural - .
Domestic use ] ]
Use to set the Category for other users Agriculture - Stock watering ] ]
Agriculture - Irrigation ] [
Spatial extent |Water management area | - | Agriculture - Aquaculture ] ]
Industrial - Category 1 ] ]
Edit Flow Table Industrial - Category 2 ] ] |
Industrial - Category 3 ] ]
Select Industrial - Category 4 ] ]
Temporal extert | apnyal | hd | Recreation - Full contact ] []
Flow assurance 10 | - | Recreation - Intermediate contact ] ]
Recreation - Hon-contact
Target flow |m¥sec U L
[ selectan || Selecthone || Apply |
Report created by: | |
Present State Refi
Category Variable Units Bound In Report Value Percentile Value
Physical Clarity NTU Lower ] el
Physical Colour Pt-Co Upper L =1
q I ] |

The RWQOs Model (vs 2.0) provides users with a standard approach to consistently
setting Resource Water Quality Objectives (RWQOs) for surface water resources in

South Africa.

By selecting the water resource and user requirements, the Model

generates RWQOs that are based on a database of provided and entered water quality

parameters.

The Model provides a quick approach to setting RWQOs based on the guidelines for
determining Resource Water Quality Objectives (RWQOs), Allocatable Water Quality and

the Stress of the Water Resource (DWAF,

2006).

Page 2
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6. Functions
The Model provides two levels of functions; these are accessible through the Toolbar and
through the Tabs.
# Resource Water Quality Objectives Beta
File Tools, Help
[ |mmuuctinm\\'<|@m [ BestAEMC | References \ Monthly-Flow | End-of-Pipe | Report |
| — N\
Toolbar
Tabs
B Toolbar
Toolbar options include:
o File
. Tools
. Help
# Resource Water Quality Objectives Beta —
. O The 'File' dropdown menu on the toolbar,
EI|E| Tools Help .
N Project allows users to create a new project,
Open Project... open an already saved project, save a
Save Project project, save a report, or print a report.
Save Project As ...
Save report as tab delimited text
Save report in comma separated format
Print...
1 Cprojects’eclipse'workspace RWQOprojectsiTest Project.xmi
Exit
# Resource Water Quality Objectives Beta The 'Tools' dropdown menu on the
Eile | Tools | Help toolbar, allows users to easily convert a
Intr| Flow Unit Converter References | Monthly-Flow | number of flow units into the required flow
(e T eliie Cale i format of m*/s and vice versa.
. Yolume from flow Calculator .
# Resource Water Quality Objectives Beta The 'Help' dropdown menu on the
File Tools | Hel
He Tools |Help) toolbar, allows users to access
Introductio| Supporting Documents...  fferences |’MonthlthIow supporting documents. e g guidelines
::m;m' o legislation; access to on-line help; and
RPN I il b o | information about the software version.
B Tabs
The 'Tabs' provide an overview of each of the working screens in the Model, namely:
e Introduction e Monthly-Flow
e Input e End-of-Pipe
e Best AEMC e Report
e References
Edition2 Page 3
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Introduction

The 'Introduction’ tab provides users with a brief overview and background to the Model.

Input

The 'Input' tab is the main input screen in the Model. Here users are required to:

1) Select (or enter) the Recommended Ecological Category (Best AEMC) for
the water resource management unit;
2) Select the desired management class for the water resource management
unit;
3) Set the spatial extent of the water resource management unit;
4) Select the desired target flows to support the determination of loads;
5) Select the desired water user categories (current and future); and
6) Enter present and reference water quality for selected parameters of
concern.
# Resource Water Quality Objectives Beta =10 x|
File Tools Help
[ ntroduction [ Input_| BestAEMC | References | Monthly-Flow | End-of-Pipe | Report |
(5) Select desired =
water user category
Project Name | |
Study Unit Name | | \<£
User Exzisting? Future? Category
Recummend4 (1) Select Best AEMC VI:_; Select International obligations [] []
| | Strategic use ] []
- _! Ecological Reserve ] []
[v] Use to set the Ecological Reserve Category O el = L ] ] L
Management cIaSS|NaturaI \bl S tmene g g _
Use to set the Category for other users (2) Select management m |
class 0 | O
Snatial extent  |yater management area | v [[ Agriculture - Aquacuture | O]
A Industrial - Category 1 | m
- . Industrial - Category 2 ] ] ]
(3) Select spatial extent SIS Industrial - Category 3 0 O
S Industrial - Category 4 ] ]
Temporal extent  |annyal |v Recreation - Full contact ] ]
Flow assurance |1 |v % Recreation - Intermediate contact Ol n
Target flow |m?;>£maliun - Non-contact m (] [ear [~]
(4) Select flow tan || SelectMone || Apply |
Report created hy: | ||
Present State Refi
CatE_gonr _ Variable (6) Present and Value Percentile Value =
Ehvsicallg Clority N1 Reference water quality —
Physical Colour Pt E
[T Il I

Each of these steps is briefly unpacked below and in more detail in the worked example in
Annexure A.

Edition2
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X Recommended ecological category

The Recommended ecological category (REC) (sourced from the Best AEMC) provides
the starting default category for the ecological Reserve category [under Users]. To select
the REC the user should go to the BestAEMC tab and select the appropriate quaternary
catchment. By doing so, the Best AEMC will automatically be filled into the Input screen.

) Select REC

Recommended ecological category

The user can choose to keep the E |A22F -
REC or deselect, to allow a Use to set the Ecological Reserve Category Best AEMC and

different ecological Reserve default ecological
category to be entered. Reserve category

X Desired management class

The Management Class, for the water resource management unit, provides the starting or
default category for the other Water Users [under Users] - [Natural=Ideal; Moderately
used/impacted=Acceptable; Heavily used/impacted=Tolerable]. The Management Class
can be selected from the available drop down menu.

Select Management
Class

Management class |Muuerate|y usedimpacted | -ﬁ |

The user can choose to keep the I4 || Use to set the Category for other users

Management Class or deselect this,
to allow different Water User
categories to be selected.

Edition2

X Spatial extent of the water resource management unit

The spatial extent defines the water resource management unit for the study. This is used
for supporting information and is not used in any of the calculations to determine the

RWQOs. Select Spatial
Extent

Spatial extent |Water management area | -

X Target flows and flow assurance

The flow is used in the Model to determine the allocatable load and the end-of-pipe
discharges. Once flows have been entered in the Monthly-Flow tab, the desired temporal
extent and flow assurance should be selected. This will automatically insert the target
flow into the required field. Flows may be edited by clicking on the Edit Flow Table button.

Edit Flow Table

Select Temporal

Extent
Temporal extent | Annual | V+ 1
Flow assurance |1|] | - %
Target flow |D_1 8 |m3Isec

Page 5
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X Desired water user categories (current and future)

The desired water user categories, both existing and future are fundamental to
determining the RWQOs.

User
International obligations

Strategic use
{_) Ecological Reserve

is) Ecological Requirements
Basic Human Needs
Domestic use

Agriculture - Stock watering
Agriculture - Irrigation
Agriculture - Aquaculture
Industrial - Category 1
Industrial - Category 2
Industrial - Category 3
Industrial - Category 4

Existing? Future? Category

Ecological Reserve
category may be
- changed from default

LI B B Q- = R I e I i O
UUUEEEE ORI ELELE]

Recreation -| Existing and future

Recreation -| water users should

Recreation - be selected

[ Selectan || SelectMone || Apphy |

RRRRRRRQRERENE

¥

Water User categories
may be changed from
default

X Present and reference water quality for selected parameters of concern

The present water quality is used to determine the water resource stress [See Reports],
while the reference water quality provides data to assess the feasibility of the determined

RWQOs.
File Tools Help
[Introduction [ Tnput_| BestAEMC | References | Monthly-Flow | End-of-Pipe | Report |
Present State Reference =

Category Variable Units Bound Value Percentile Value Percentile
Physical Clarity NTU Lower =l
Physical Colour Pt-Co Upper ¥
Physical Odour TON Upper \
Physical Temperature “C Upper \ =

Lower —
Physical Hardness (CaCOS) mai Upper Present and reference
Physical TSS mgi Upper water quality can be -
Physical Turbidity NTU Upper entered by the user
Chemical Akalinity (CaC0O_) g, Upper
Chemical Ammonia (NH_-N)} 4, Upper -
Chemical Calcium mgl Upper
Chemical Chloride mgi Upper
Chemical Chlorine (QHCI) pgl Upper

Lower
Chemical Conductivity mSm Upper 3
Chemical Fluoride mgil Upper I
Chemical Magnesium mgi Upper
Chemical NO,and NO_ mgi Upper
Chemical N03 (Nog'm mgi Upper
Chemical N03 mgi Upper
Chemical NO, man Upper —
Chemical TIN mai Upper =

[4]

4]

Edition2
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[ | Best AEMC

The 'Best Achievable Ecological Management Category (Best AEMC)' tab allows users to
automatically select the Recommended Ecological Category for a given quaternary
catchment. The Best AEMC was determined by specialists with local knowledge of the
various catchments (Kleynhans, 1999).

# Resource Water Quality Objectives Beta I =a] x|

File Tools Help
[‘Introduction | Input | BestAEMC | References | Monthly-Flow | End-of-Pipe | Report |

Best AEMC for the selected quaternaty catchment is used to set the default recommended ecological category

Order nz ® Quaternary ) Stream Name
Quaternary Sl Rivers [ EISC PESC Best AEMC
AT0A I [HIGH CLASS C: MODERATELY ... [CLASSE -
A10B ) AL CLASS C: MODERATELY ... [CLASSE =]
410G Users can sort alphabetically |, CLASS B: LARGELY NATU... [CLASS A
A21A by quaternary catchment or |ja_ CLASS C: MODERATELY ... |CLASS B
4216 by stream name CLASS C: MODERATELY ... [CLASSE
A21C CLASS D: LARGELY MODL... [CLASS ©
421D BLOUBANKSPRUIT MODERATE CLASS C: MODERATELY ... [CLASSE
A21E CROCODILE MODERATE CLASS C: MODERATELY ... [CLASSE
A21F MAGALIES MODERATE CLASS C: MODERATELY ... [CLASSE
421G SKEERPOORT MODERATE CLASS C: MODERATELY ... [CLASSE
A21H CROCODILE MODERATE CLASS C: MODERATELY ... [CLASSE
421 CROCODILE MODERATE CLASS C: MODERATELY ... [CLASSE
A21K STERKSTROOM MODERATE LhCncowanCoaTol CLASS B
AZ1L e MODERATE Category selected provides [|CLASSE
A2 Select desired MODERATE the default Ecological CLASS B
A22E ER MODERATE CLASS B
— quaternary catchment e Reserve Category SR
4220 SELONG MODERATE CLAGG C Moow 7. [CLASSE
822E L ELANDS R MODERATE CLASS C: MODERATED [CLASS B
AZ2F ELANDS MODERATE CLASS D: LARGELY MODL... [CLAGE €
422G HEX RIVER MODERATE CLASS C: MODERATELY ... [CLASSE
A22H HE® RIVER MODERATE CLASS D LARGELY MODL... [CLASSE
422 HEX MODERATE CLASS C: MODERATELY ... [CLASSE
23R PIEMAARS MODERATE CLASS C: MODERATELY ... [CLASSE
[ | References

The 'Reference tab' provides the input water quality data for various water user types,
and is used to determine the RWQOs. For certain water users, the water quality data are
automatically provided in the Model [Reference tab], based on the South African Water
Quality Guidelines (DWAF, 1996) (e.g. Domestic Use, Agriculture, Industrial, and
Recreation) — these are accessible under Help > Supporting Documents. In addition,
default water quality data are provided for Ecological Requirements (in the absence of an
ecological reserve) (Palmer et al., 2005) and Basic Human Needs (Class 1) (WRC, 1998).

If applicable to the catchment, users are required to enter the water quality in the
'Reference' tab for:

. International obligations;

. Strategic use; and

. Ecological Reserve.
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File Tools Help

(‘ntroduction | Input | BestAEMC | References | Monthly-Flow | End-ofPipe | Report |

# Resource Water Quality Objectives ' _

—lol x|

Bound
Lower
Upper
Upper
Upper

Category \fariable Units
Physical Clarity NTU
Physical Colour Pt-Co
Physical Odour TON
Physical Temperature “C
Physical Hardness (Ca(

Reference water quality
from the South African
Water Quality Guidelines

Physical TSS

Physical Turbidity

Chemical Alkalinity (CaC03) mgi
Chemical Ammonia (NH3-H) mgl
Chemical Calcium mgi
Chemical Chloride mgi
Chemical Chlorine {OHCI) pgil
Chemical Conductivity mSim
Chemical Fluoride mgl
Chemical Magnesium mgi
Chemical WO2 and HO3 mgl

UDIJN
Upper
Upper
Upper
Upper
Lower
Upper
Upper
Upper
Upper

Ideal

200

0.1

80.00
100.00
0.60
0.30
70.00
0.70
70.00
6.00

Domestic use
Acceptable

Joo

150.00
200.00
0.20
0.20
150.00
1.00
100.00
10.00

Tolerable

600

20

300.00
G00.00
1.00
0.10
370.00
1.50
200.00
20.00

Agriculture - Stock waterir

Ideal

1000.00
1000.00

2.00
500.00

Acceptable

1500.00
1750.00

4.00
#50.00

'y

The ecological Reserve water quality data are entered for the selected ecological Reserve
category, as determined from the Reserve process.
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# Resource Water Quality Objectives -1ol x|
File Tools Help
[‘ntroduction | Input | BestAEMC [ References | Monthly-Flow | End-of-Pipe | Report |
Ecological Reserve
Category Variable Units Bound A B C D Natural
Physical Clarity NTU Lower =l
Physical Colour Pt-Co Upper
Physical Odour TON Upper
Physical Temperature “C Upper
Lower S5
Physical Hardness (CaC03) mgil Upper
Physical TS5 mgi Upper
Physical Turbidity NTU Upper | |
Chemical AlKkalinity (CaC03) magi Upper
Chemical Ammonia (NH3-H) mgi Upper 0.015
Chemical Calcium mgl Upper
Chemical Chioride mgi Upper | Water quality to be
Chemical Chiorine (OHCI) poi upper ||| entered for the selected 0.4
Lower || ecological Reserve
Chemical Conductivity mSim Upper | category ~ :
Chemical Fluoride mal upper || 2183 1.500
Chemical Magnesium mgl Upper 147
Chemical NO2 and HO3 magi Upper
Chemical NO3 (NO3-N) mgi Upper .21
Chemical NO3 ol Unper
Chemical NO Additional variables may be
Chemical TI added to the References 0.25
chemical pH| which will appear in the Input 7.6 8.0
and Report worksheets 5.4 6.50
Chemical = |
T D] |
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There is no
ecological
Reserve?

If an Ecological Reserve has not been set for the water resource
management unit, the Model will automatically use the ‘Ecological
Requirements' (Palmer et al., 2005) for the default Ecological Reserve
Category, as determined from the Best AEMC.

[ | Monthly Flow

Target flows and flow assurances are used to set the 'Allocatable Load', i.e. the water
quality over and above that required for the RWQOs, i.e. that which can be allocated for
use.

The flows are entered into the 'Monthly Flow' tab. This can be done in two possible ways,
either by:
e Typing the monthly flows into a given flow assurance column, e.g. 10%, or
e Importing the monthly flows as derived from the SPATSIM database (*.rul file), i.e.
the output of the Reserve process.

? The monthly flows can be imported as either m®s or Mm®month. If the
SPATSIM *.rul file is being imported, it is important that the header rows
remain in the file. The Model will read these lines, to determine the
import flow units.

What units
should the
flows be in?

=10 x|

File Edit WView Insert Format Help

D2|E] Sl | 5 m(@]-] ®)|

lDesktop Version 2, Printed on 2006/06/20 =

Summary of IFR rule curves for : R30E WRS0 Incr.

Determination based on site specific parameters from SPATSIM database

Regional Type : E.Cape ERC = B These header rows

) ) ) should not be deleted
Data are given in m™3 * 1076 monthly flow volume from the import * rul file
% Points

Month 10% 20% 30% 40% 50% 60% T0% 80% 90% 39%

Oct 1.083 1.041 05953 0.805 0.609 0.410 0.255 0.165 0.127 0.122 ==

Hov 4,365 3.931 2.460 1.730 1.130 0.854 0.529 0.346 0.272 0.110

Dec 1.1&67 1.005 0.853 0.692 0.465 0.321 0.197 0.11%9 0.086 0.070

Jan 0.675 0.651 0.601 0.514 0.391 0.255 0.140 0.069 0.040 0.020

Feb 0.831 0.803 0.744 0.640 0.4582 0.327 0.184 0.094 0.055 0.010

Mar 2.018 1.654 1.323 1.012 0.600 0.384 0.219 0.127 0.08% 0.020

Apr 1.024 0.985 0.900 0.758 0.571 0.380 0.231 0.145 0.090 0.070

May 0.386 0.371 0.341 0.2390 0.222 0.153 0.100 0.069 0.056 0.054

Jun 0.289 0.277 0.24% 0.205 0.152 0.103 0.06%9 05051 0.044 0.043

Jul 0.341 0.326 0.294 0.244 0.182 0.124 0.082 0.060 0.051 0.049

Ang 1.048 0.670 0.460 0.360 0.290 0.240 0.210 0.150 0.123 0.100

Sep 0.888 0.854 0.782 0.660 0.440 0.330 0.211 0.137 0.107 0.100 _I

-

For Help, press F1 l_l_ 4

To import flow data, click the | _mport __|Monthly-Flow' tab. This will take
users to an 'Open’ screen where you can locate the file for import.
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# Resource Water Quality Objectives Beta ' s =181 x]|

File Tools Help
[‘ntroduction | Input | BestAEMC | References | Monthly-Flow | End-of-Pipe | Report |

Monthly Flows
Summary of IFR rule curves

# Data may be entered directly (units must be mgfs), ot
# Data (as extracted fromn SPATSIM database) may be imported (utits as mgfs ot xl 06 mg.-fmonth).
Drata inported az =1 06 mgfmonth will autornatically be converted to mg.-fs

{ensure that headings in file remain) ; =
Z Open ! x|
Look In: |ﬁ RWOQO vs3 |v| . . . i
% Points == E
Month 10% 20% 30%

Fa— 1 docs [} R30E_mem.rul I
ikt _—— Locate *.rul file i
December [ projects >

for import -
January ] reports I
February [ stage 1
March =7 thirdparty L
April [} R30E_m3s.rul 1
May |
June File Hame: |R30E_m33.rul | ||
J
uly Files of Tyne: [IPR rule files (.rul) I~] F

August ||
September | | | |

oK canc Open Cancel

{] Il I [

Once imported, the 'Monthly-Flow' tab will be populated with flow assurance values to be
used in the Input Tab.

2 Resource Water Quality Objectives Beta - 0] x|
File Tools Help

{ Introduction | Input | BestAEMC | References | Monthiy-Flow | End-of-Pipe | Report

Time frame | 10% 20% 30% 40% 0% B0% 70% 0% 50% 99%
Annual 0.467 0.399 0316 0.251 0176 0173 0.077 0.048 0.036 0.024
Annual - Le..|0.466 0.398 0316 0.251 0176 0173 0.077 0.048 0.036 0.024
October  [0.404 0.354 0.356 0300 0.227 0.153 0.095 0.061 0.047 0.045
Movernber  |1.816 1.517 0.849 0667 0.436 0.330 0.204 0133 0.10% 0.047
Decermber |0.436 0.375 03149 0.25% 0174 0,120 0.074 0.044 0.032 0.076
January  [0.252 0.243 0.275 0192 0.145 0,095 0.057 0.026 0.015 0.007
February  |0.343 0.332 0.307 0.264 0.204 0.135 0.076 0.039 0.023 0.004
February- ... |0.343 0.332 0,307 0.264 0.204 0135 0.076 0,039 0.023 0.004
March 0.754 [E 0496 0.37% 0.224 0143 .06z 0.047 0.033 0.007
(il 0.395 0.380 0.347 0.292 0.220 0146 0.089 0.056 0.035 0.027
May 0144 0139 0127 0103 0.083 0.057 0.037 0.026 0.021 0.020
June 0112 0107 0,096 0.079 0.059 0.040 0.027 0.020 0.017 0016
duly 0.127 0122 0110 0.091 0.065 0,046 0.031 0022 0.019 0013
August 0.391 0.250 0172 0.134 0108 0,040 0.073 0.056 0.046 0.037
September [0.343 0.379 0,302 0.255 0170 0127 0081 0.053 0.041 0.039
ALtumn 0577 0.501 0.473 0.336 0.272 0144 0.08% 0.051 0.034 0.017
winter 0.1a4 0155 0176 0.103 0.080 0.05% 0.043 0.031 0.026 0.023
Spring 0.374 0.3549 0.379 0.27% 0199 0.140 0.06% 0.057 0.044 0.047
Surnmer  |0.737 0.616 0.449 0.345 0.239 0170 0101 0.060 0.044 0.020
Surnmer- ... |0.734 0.614 0.44% 0.344 0.239 0169 0101 0.060 0.044 0.020
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| J

How do | edit
flows after |
have imported

them? /
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Monthly flow data are sourced from the SPATSIM database, obtainable
from the Directorate RDM. Flows should be requested for the point or
catchment for which the RWQOs are being set.

If you need to edit the monthly flows after having imported the *.rul file,
you can do this by clicking on the button in the 'Input' tab
or k| Edit Flow Table }s button in the Monthly-Flow tab.

Edit

End-of-pipe

The 'End-of-Pipe' tab, allows users to work back to point source effluent discharges, to
determine the end-of-pipe discharge(s) that may be allowed in order to achieve the
RWQOss. The 'End-of-Pipe' tab makes use largely of data that have already been entered
within the other tabs. The only data to be entered in the 'End-of-Pipe' tab are the data for

Edition2

'Effluent Flow'.
# Resource Water Quality Objectives =10 x|
File Tools Help
[ ntroduction | Input |" BestAEMC | References | Monthly-Flow | End-of-Pipe | Report |
=
Automatically filled from B
target flow (Input tab)
Upriver Flow (Qs) 3a9|
Effluent Flow (Ow) _|0.013 |
Upriver Effluent Downriver Mixing
To be entered by u;I Concentration (Cs) Concentration (Cw) Flow {Qr) Concentration (Cr) Ratio
ardness (CaC03) mgil 0.412(100.000 0.033)*]
S5 mal 0.412(25.000 0.033
Ikalinity (Cac03)  mad 0.412[300.000 0.033
mmonia (NH3-N)  mgi 0.412 0.033
alcium mal  |33.8 6,628.754 0.412[300.000 0.033| _
hloride mal 1021 669.392 0.412(120.000 0.033
hlorine (OHCI) oA 0.412[1.000 0.033 L
luoride mal |23 0.000 0.412)1.500 X 0.033
agnesium mal 68T 4,229.900 0.412[200.000 0.033 |
02 and NO3 mg 041220000 —
03 (NO3.N) e Automatically filled
v s Calculated by from calculated
o mg1 || Automatically filled Model based on RWQOs (Report tab)
i sl from present water input data 0.033
otassium mal quality (Input tab) 0.412[100.000 0.033
04 mag 0.412 0.033
AR mmold 0.412[15.000 0.033
odium ma 0.412[115.000 0.033
04 mgl 0.412(30.000 0.033 ||
ulphide (H25) mail 0.412 0.033
DS ma 0.412/450.000 0.033
1 mgl 0.412[20.000 00335 [o
a I D
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& Effluent Concentration (Cw)

The Effluent Concentration (Cw) calculated in the Model is the total allocatable effluent
quality — this may be assigned to a single user or to multiple users. It is up to the
user to determine how the effluent concentration will be assigned within a catchment
or river reach.

[ Report

Having entered all of the necessary data into the input screen, the user may view the
results in the 'Report' tab. The report provides a:
(1) review of the present and reference water quality, and
(2) results of:
¢ RWQOs;,
e Resource stress;,
e The allocatable water quality and associated confidence; and
e The allocatable loads.

# Resource Water Quality Objectives il =0 x|

File Tools Help
[ ntroduction |“Input | BestAEMC | References | Monthly-Flow | End-of-Pipe | Report |

Selected input
parameters
Selected input
Project: Bleshokspruit RWQ0s Water Use Existing? Future? Quality parameters
Study Unit: Bleskborkspruit - C21D International obligations O ] Tolerable
Best AEMC: Strategic use O 1 Tolerable
Management Class: Fair Ecological Reserve O O o
Spatial Extent: Quaternary catchment Ecological Requirements O [ Fair
Temporal Extent: Annual Basic Human Needs Tolerable
Flow Assurance: 20 % Domestic use Tolerable
Target Flow: 0.399 m°/sec = 12.583Mm fannum  Agriculture - Stock watering O 1 Tolerable
Prepared on 2006/07/03 Agriculture - Irrigation Tolerable
using version Beta Agriculture - Aguaculture O [ Tolerable
Industrial - Category 1 Tolerable
Industrial - Category 2 Tolerable
Industrial - Category 3 Tolerable
Industrial - Category 4 Tolerable
Recreation - Full contact O [ Tolerable
Recreation - Intermediate contact [ | L1 Tolerable Allocatable
Recreation - Non-contact O [ Tolerable water quality
Water Quality Variahle Present State Reference RWQO Stressed? Allocatable Water Quality Allocatable Loads
Category Variable Units Bound Value Percentile ValuePercentile Value Confidence Tonnes/annum Percentile
Chemical Calcium mgl Upper 93.8 95.0 62.6 95.0 300.000 Ho 206.200 95.0 2,504.587
Chemical Chloride mgl Upper 1021 95.0 491 95.0 120.000 Ho 17.900 95.0 225.233
Chemical Conductivity mS/m Upper 134.5 95.0 68 95.0 70.000 Yes -64.500 95.0
Chemical Fluoride mg1 Upper 2.3 950 0.8 950 1500 Yes -0.800 95.0 -10.066
Chemical Magnesium mg1 Upper 68.7 95.0 47.3 95.0 200.000 Ho 131.300 95.0 1,652.130
Resultant Ss)t/fézgn
RWQOs
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& Parameters of Concern

For the RWQOs of a particular variable to appear in the 'Report’ tab, that variable must
have been selected in the 'Input’ tab as a parameter of concern. This should be done
by the required variable.

determined by

El The Model determines the RWQOs by selecting the lowest or most
sensitive water quality, for each variable of concern, for each selected
water user (existing and future). The water quality requirements are
extracted from entered water quality data (Reserve, International
the Model? Obligations, Strategic Use) and default SA Water Quality Guideline data.

How are the
RWQO

The stress of the resource is the difference between the proposed
’7| RWQOs and the present water quality.

How is Stress . . .
determined by RWQOs > Present = unstressed (water quality available for allocation)

the Model? RWQOs < Present = stressed (no water quality available for allocation)

& Saving and Exporting the results

Reports that have been generated for a project can be saved or printed, allowing users
to modify input criteria and assess the impact of these changes on the resultant
RWQOs.

The results can be exported as either 'tab delimited text' or in 'comma separated
format'. The 'tab delimited text' option allows users to open the report in e.g. Notepad,
MS Word, WordPerfect, while the ‘comma separated format' allows users to open the
report in e.g. MS Excel.

To export or save the report, go to >> File >> Save Report. Select either ‘As tab
delimited text' or 'In comma separated format'.

# Resource Water Quality Objectives
File| Tools Help
Hw Projct Encotpe | Revort ||
Open Project...
Save Project
Save Project As ...
Save Report... ¥ As tab delimited text
Erint... In comma separated format
1 Ci\projects'eclipse'workspace'RW0O O projectsi\Test Project.xml e E E
Exit irements O ]
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7. Data requirements

To determine RWQOs, the Model requires the following input data:
e Ecological category — from a Reserve or Best AEMC

¢ Management Class — from a catchment visioning exercise

e Target flows — from Reserve output - *.rul files

e Existing and future water users within the water resource management unit
e Present water quality — 5™ and 95" percentiles

e Reference water quality — 5" and 95" percentiles
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INPUL...coveiiiieecee e 3,4,10, 11,13
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Report ...ccoeeeiiiiei 3,12, 13
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